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Chapter 1. IBM Campaign 10.0 system requirements and
compatibility

IBM® Campaign is part of the IBM Marketing Software suite of products.
Campaign version 10.0 requires Marketing Platform 10.0.

Where to find complete system requirement and compatibility
information

For a list of IBM Marketing Software product versions compatible with this
product and a list of third-party requirements for this product, see the
Recommended Software Environments and Minimum System Requirements document.
This document is posted under Detailed System Requirements on the IBM Support
Portal website: (http://support.ibm.com).

You can also access this document by selecting Help > Product documentation
when you are logged in to IBM Marketing Software.

Prerequisites for using IBM Campaign
Before you begin using IBM Campaign, confirm that your environment meets the
following requirements.
v For an improved user experience, use at least a 21" screen.
v For an improved user experience, set your screen resolution to 1600 x 900.

Lower resolutions can result in some information not being properly displayed.
If you use a lower resolution, maximize the browser window to see more
content.

v A mouse is best for navigating in the user interface.
v Do not use the browser controls to navigate. For example, avoid using the Back

and Forward buttons. Instead, use the controls that are in the user interface.
v If pop-up blocker (ad blocker) software is installed on the client machine, IBM

Campaign might not function properly. For best results, disable pop-up blocker
software while running IBM Campaign.

v Ensure that the technical environment meets the minimum system requirements
and the supported platforms.*

v The correct browser and versions must be used.*
v Clear the browser cache after upgrading or applying any fix pack. This only

needs to be done once, after the application is updated.
v If you use Internet Explorer (IE) with IBM Campaign or any module that uses

Campaign flowcharts (eMessage, Contact Optimization, Interact, Distributed
Marketing): To log in multiple times to view side-by-side information, open IE
and log in to IBM Marketing Software. Then select File > New Session in the IE
menu bar. In the new IE browser window, log in to IBM Marketing Software as
the same or a different user.

Important: Do not use any other method to open multiple sessions. For
example, do not open a new tab; do not open another browser session from the
Start menu or desktop icon; and do not use File > New Window in IE. These
methods can corrupt information that is shown in the application.
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*For details on the items indicated by an asterisk, see the IBM Marketing Software
Recommended Software Environments and Minimum System Requirements.

IBM Campaign documentation roadmap
IBM Campaign provides documentation and help for users, administrators, and
developers.

Table 1. Get up and running

Task Documentation

Find out about new features, known issues, and
limitations

IBM Campaign Release Notes

Learn about the structure of the Campaign
system tables

IBM Campaign System Tables and Data Dictionary

Install or upgrade Campaign One of the following guides:

v IBM Campaign Installation Guide

v IBM Campaign Upgrade Guide

Implement the IBM Cognos® reports provided
with Campaign

IBM Marketing Software Reports Installation and Configuration Guide

Table 2. Configure and use Campaign

Task Documentation

v Adjust configuration and security settings

v Prepare Campaign for users

v Run utilities and perform maintenance

v Learn about integrations

IBM Campaign Administrator's Guide

v Create and deploy marketing campaigns

v Analyze campaign results

IBM Campaign User's Guide

Improve flowchart performance IBM Campaign Tuning Guide

Use Campaign functions IBM Macros for IBM Marketing Software User's Guide

Table 3. Integrate Campaign with other IBM products

Task Documentation

Integrate with IBM Engage IBM Campaign and Engage Integration Guide for IBM Marketing
Cloud

Integrate with IBM Journey Designer http://www.ibm.com/support/knowledgecenter/SSER4E/
JourneyDesigner/kc_welcome_journeydesigner.dita?lang=en

Integrate with IBM Digital Analytics IBM Campaign Administrator's Guide: How to configure the
integration.

IBM Campaign User's Guide: Targeting IBM Digital Analytics
segments in campaigns.

Integrate with IBM Marketing Operations IBM Marketing Operations and IBM Campaign Integration Guide

Integrate with IBM Opportunity Detect IBM Campaign Administrator's Guide: How to configure the
integration.

IBM Opportunity Detect Administrator's Guide and IBM
Opportunity Detect User's Guide: How to administer and use the
product.
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Table 3. Integrate Campaign with other IBM products (continued)

Task Documentation

Integrate with IBM eMessage IBM Campaign Installation and Upgrade guides: How to install and
prepare eMessage components in the local environment.

IBM eMessage Startup and Administrator's Guide: How to connect
to the hosted messaging resources.

IBM Campaign Administrator's Guide: How to configure offer
integration.

Integrate with IBM SPSS® Modeler Advantage
Enterprise Marketing Management Edition

IBM Campaign and IBM SPSS Modeler Advantage Enterprise
Marketing Management Edition Integration Guide

Note: Additional integrations may be available that are not listed in this table. See Product tools and utilities for
IBM Campaign. Also see IBM Solution Engineering Projects.

Table 4. Develop for Campaign

Task Documentation

Use the REST API See the IBM Knowledge Center

Use the SOAP API v IBM Campaign SOAP API Guide

v JavaDocs in devkits\CampaignServicesAPI

Develop Java™ plug-ins or command-line
executables to add validation to Campaign

v IBM Campaign Validation PDK Guide

v JavaDocs in devkits\validation

Table 5. Get help

Task Instructions

Use the IBM Knowledge Center Go to http://www.ibm.com/support/knowledgecenter/
SSCVKV/product_welcome_kc_campaign.dita

Open online help When using the IBM Campaign application:

1. Choose Help > Help for this page to open a context-sensitive
help topic.

2. Click the Show navigation icon in the help window to
display the full help.

You must have web access to view context-sensitive online help.
Contact IBM Support for more information about accessing and
installing IBM Knowledge Center locally for offline
documentation.

Get PDFs When using the IBM Campaign application:

v Choose Help > Product documentation to access Campaign
PDFs.

v Choose Help > All IBM Marketing Software documentation
to access all product PDFs.

v Click the links for PDFs during the installation process.

Get support Go to http://www.ibm.com/ and click Support & downloads to
access the IBM Support Portal.
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Chapter 2. New features and changes in version 10.0

IBM Campaign 10.0 includes a number of new features and changes.

For a list of newly supported and discontinued platforms, see the document
Recommended Software Environments and Minimum System Requirements, which is
posted under Detailed System Requirements on the IBM Support Portal
(http://support.ibm.com).

Upgrade paths

Because version 10.0 is a major release, you can upgrade from 8.6.x, 9.0.x, or 9.1.x.
For instructions, see the IBM Campaign Upgrade Guide.

Enhanced user interface for Marketing Platform, Campaign,
Interact, and Contact Optimization

This release updates the user interface so that it is easy to use, offers a clean,
modern design, and delivers improved inline text and error messages. The new
look does not change how the product works, and you can get updated
documentation from the Help menu.

Context-sensitive help for Configuration properties

When you view configuration properties under Settings > Configuration, you can
choose Help > Help for this page to display context-sensitive help. For example, if
you request help for the Campaign | caching page, you see a help topic that
specifically describes all of the caching options. You must have an internet
connection to use this feature.

EMM files and directories renamed to IMS

Files and folders that included "EMM" have been changed to IMS. For example,
the default top-level directory is now C:\IBM\IMS and the names of the installers
are IBM_Marketing_Software_Installer_10.0.0.0_linux.bin,
IBM_Marketing_Software_Installer_10.0.0.0.sh, and
IBM_Marketing_Software_Installer_10.0.0.0_win.exe.

Integration with IBM Engage in the IBM Marketing Cloud

IBM Campaign v10.0 can be integrated with IBM Engage in the IBM Marketing
Cloud. IBM Engage provides digital marketing and lead management solutions
incorporating email, SMS, and mobile push, along with embedded analytics. The
integration provides digital marketers with the ability to personalize and track
each customer interaction, communicate over multiple channels, and protect
sensitive personal data. Marketers can use the IBM Campaign segmentation
capabilities together with IBM Engage to target specific audiences, personalize
communications, and reach customers through email, SMS text messaging, and
mobile push campaigns. For details, see the IBM Campaign and Engage Integration
Guide for IBM Marketing Cloud.
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Integration with IBM Journey Designer

IBM Campaign customers can now use IBM Journey Designer to design and view
high-level journey maps to empathetically understand the messaging and
touchpoints that their customers go through. IBM Campaign users can use Journey
Designer to strategically plan out the ideal customer journey and the different
interactions that happen across that journey. As you create journeys, you can link a
particular interaction to an existing campaign, assign requests to a particular user
to execute and collaborate on what needs to be included in that particular
campaign. For information, see the separate Journey Designer documentation.

Advanced search for campaigns, sessions, offers, segments
(181352, 211268)

You can search for flowcharts and flowchart-related objects, including names of
process boxes, configuration details, descriptions, owners, user variables, user
database tables, segments, associated offers, and any other objects that are stored in
campaign session files (.ses).
1. Go to any of the following locations:
v The All campaigns page
v The All sessions page
v Any flowchart tab in View mode

2. Click Search flowcharts.

When you do a search, all flowcharts in all campaigns in the current partition are
searched. Searching is not case-sensitive. Currently, the search results persist until
you explicitly clear the results. For more information, see the IBM Campaign User's
Guide.

Note: Flowcharts are not searchable until you index them. See below for more
information.

Make flowcharts searchable by indexing the .ses file

Version 10 introduces the ability to search flowcharts. However, flowcharts are not
searchable until you index them. There are two ways to make flowcharts
searchable:
v Batch index all flowcharts in a partition by running advSrchUtil (.bat or .sh),

or
v Index a single flowchart by running unica_acsesutil with the -J option.

Existing indexes are not updated automatically. To ensure accurate search results,
follow these guidelines:
1. Run advSrchUtil immediately after upgrading IBM Campaign, to index all

existing flowcharts in a partition.
2. Run advSrchUtil periodically to create or update search indexes on all

flowcharts in a partition.
3. If you want to affect just a single flowchart, run the unica_acsesutil session

utility with the -J option.

When advSrchUtil runs for the first time, it processes all flowcharts in the given
partition by serializing them into JSON and indexing them.
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The next time advSrchUtil runs, it processes only the flowcharts that were
modified or added since the last run.

For this reason, the first run takes longer than subsequent runs. A very large
flowchart can take several minutes to process, so if there are many flowcharts the
tool may take a long time to finish. Best practice is to run the tool regularly. For
example, if you typically add or modify hundreds of flowcharts per week, consider
running the tool twice a week.

The following examples summarize how to run the commands. For complete
information, see the IBM Campaign Administrator's Guide.
v Unix/Linux: <Campaign_Home>/bin/advSrchUtil.sh <partition>

<campaignSharedHome if clustered>

v Windows: <Campaign_Home>\bin\advSrchUtil.bat <partition>
<campaignSharedHome if clustered>

The utility interactively prompts for a user name and password that has
permission to access all of the flowcharts in the given partition. The
campaignSharedHome is required only if the IBM Campaign listener is clustered.
v unica_acsesutil -s <Flowchart ses file> -h <partition_name> -J -o

<output_file_or_directory_path> -y <user_id> -z <password>. You must
include -s to indicate the session file. The options -y and -z are optional; if you
omit them, the tool prompts for user ID and password. All options are
case-sensitive.

GSKit replaces OpenSSL as the cryptography standard. (Epic
130497, Story 199501, Task 211566)

To configure GSKit, follow the instructions in the IBM Marketing Platform
Administrator's Guide. The high-level steps are summarized below:
1. Generate Campaign certificates using IBM GSKit and configure settings in

CAMPAIGN_HOME/conf/config.XML.
2. Generate JAVA certificates.
3. Exchange IBM Campaign GSKit certificates with JAVA certificates.
4. Configure SSL certificates in the WebSphere® or WebLogic application server.

Note: For upgrades: Existing customers with SSL environments must remove the
SSL certificates and configure new certificates using GSKit. Existing SSL certificates
will not work. For instructions, see the GSKit documentation and the IBM
Marketing Platform Administrator's Guide.

Hortonworks ODBC driver support (211291)

The Apache Hortonworks 64-bit ODBC driver for HDP 2.3 (v2.0.5) is now
supported as a driver for Hive-based Hadoop big data (user data sources only).

New environment variable for listener script:
STALE_CONN_TIMEOUT (204453)

A new environment variable, STALE_CONN_TIMEOUT, is available for the listener
script file for IBM Campaign and Contact Optimization. The listener script file is
rc.unica_ac/cmpServer.bat (for Campaign) and ACOServer.sh/.bat (for Contact
Optimization), located in <CAMPAIGN_HOME>\bin.
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The STALE_CONN_TIMEOUT variable was introduced to enable long-running
campaigns to continue without losing connection to the back-end database. If a
connection is idle for the number of seconds defined, the connection will be
re-opened. For example: STALE_CONN_TIMEOUT=<seconds>. If you add or change this
environment variable, you must restart the listener. If a connection is lost, the
following debug message appears in the Campaign flowchart or Contact
Optimization server log file: [DB QUERY] Connection is stale, so re-opening DB
connection.

Hive ODBC.ini file requires additional parameter
GetTablesWithQuery=1 (206508)

If you are using a Hive-based Hadoop big data source as a user database, the
ODBC.ini file for your Hive ODBC driver must include the line
GetTablesWithQuery=1. This line is necessary to address a Hive limitation of the
GetTables ODBC API. Omitting this line can result in a connection timeout error
for the Hive Hadoop datasource. This change applies to all Hive ODBC drivers.
For more information, see the IBM Campaign Installation Guide.

New configuration property in Teradata data source template:
UseGroupByForDistinct

A new property,
Campaign|partitions|partition[n]|dataSources|dataSourcename|
UseGroupByForDistinct, was added to the Teradata datasource template. By
default, this property is FALSE. When this property is enabled, <select query> uses
a GROUP BY statement instead of DISTINCT.

The reason for this addition: Flowcharts execute the query "select DISTINCT
<audience id> from <table>" to fetch unique records when a table is not mapped
as a normalized table in IBM Campaign. When such queries are submitted against
Teradata, it causes additional sorting of data on the database and high CPU
consumption. The Teradata DBA recommendation is to use GROUP BY instead of
DISTINCT, because GROUP BY can take advantage of Teradata multi AMP
processing architecture.

New configuration property: cacheSystemDSQueries

A new configuration property,
Campaign|partitions|partition[n]|server|optimization|cacheSystemDSQueries,
was added to improve performance. When set to TRUE, this property reduces
multiple execution of queries on the IBM Campaign system tables by caching the
query results. When set to FALSE, query results are not cached. The default value
is TRUE.

Ability to enable trace logging in unica_aclsnr.log for diagnostic
purposes

You can enable trace logging for diagnostic purposes, when working with IBM
Support. When you enable trace logging, trace events are written to both the
listener log unica_aclsnr.log and the flowchart log <flowchart>.log. Trace events
are identified in the log file by [T].

To enable trace logging:
1. Add the following entry to the setenv.sh or setenv.bat file: UNICA_ACTRACE=Trace
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2. Restart the listener.

Note: Trace logging can degrade performance so be sure to disable it (comment
out the line and restart the listener) after you are done.

Web application clustering Suite-wide

Previously, Web application clustering was supported only for stand-alone
Campaign. Now, web application clustering is supported for IBM Campaign along
with other integrated products in the Suite. For example, if Campaign is deployed
in a web application cluster then the user can configure IBM Marketing Platform,
Contact Optimization, Marketing Operations, or eMessage in the same web
application cluster. Even though Interact does not support web application
clustering, it can also be configured with the IBM Campaign application deployed
in a web application server cluster. Only Sticky sessions are supported. No session
replication is done, as the focus is on scalability. Failover is not implemented.

Performance enhancement (195323)

For Campaign+Marketing Operations integrated environments, performance has
been improved on Save and Exit Flowchart.

New option during installation to create a system table data
source connection in the web application server

You can allow the installer to create the connection to the Campaign system tables
in the web application server. To enable automatic data source creation during
installation, on the Datasource Creation panel, select the Create Campaign
Datasource check box and supply information about your application server.
v The installer creates the data source using campaignPartition1DS as the JNDI

name.
v The installer creates the data source connection for one partition only. If you

have multiple partitions, you must create additional connections manually.
v Note that, if you are using WebLogic, you must add the JDBC driver to your

web application server classpath manually even if you allow the installer to
create the data source. The installer does this automatically for WebSphere.
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Chapter 3. Fixed defects in IBM Campaign 10.0

The following defects were fixed in Campaign 10.0.

Table 6. Campaign fixed defects

ID Fixed defect

223812 Doc Defect: Package ID behavior 20595

221776 VERSION: 213486: Unable to save Custom Campaign Attributes in 9.1.2.1 -- ATTRIBUTE is invalid. Please
reduce the length of the text.

221775 VERSION: 212799: 'OK' button on 'More Options' window does not close the dialoge upon clicking. User
has to click Cancel button instead of OK

221774 VERSION: 211648: The extracted derived field in a Call List process box is lost when the process boxes are
copied into a new flowchart.

221639 Server Busy (10453) message is reported when large flowchart with complex processing.

221576 "NEXT" BUTTON REMAINS GRAYED OUT IN IBM CAMPAIGN TABLE MAPPING SCREEN EVEN
AFTER SELECTING CORRECT AUDIENCE FIELD.

219636 Error 11107 appears when pasting template in new flowchart.

219311 10404 error occurs when profiling

219309 MAIL LIST PROCESS BOX CRASHES 10404

219304 Core file issues which are reported in PMR 209964 in OCBC customer environment

219004 unica_svradm STOP command pauses flowchart, that is scheduled using Schedule process box, instead of
stopping it

218512 flowchart gets stuck during cut or copy operation

216932 WITH IN-DB OPTIMISATION ACTIVATED, CAMPAIGN DROPS TEMP TABLES WITHOUT
CANCELLING THE QUERY

216922 The issue is that the User Authorization time reported appears to always be 5 hours ahead of time (GMT)
from when the actual time is reflected in the User Authorization List (from the server)

216921 Cannot assign product to offer - "Invalid Data Format for Relevant Product(s)."

216875 Search functionality is not fully working in Target Cells spreadsheet in Edit Mode

216785 No DB2 SQL Datafiltering when selection box include

216715 VERSION: 213762: PRE:VALUES IN PARAMETER TAB FOR CALLLIST PROCESS BOX ARE RESET

216714 VERSION: 211648: The extracted derived field in a call list process box is lost when the process boxes are
copied into a new flowchart.

216711 VERSION: 198717: Maillist offer attributes get incorrect value

216709 VERSION: 212799: 'OK' button on 'More Options' window does not close the dialogue upon clicking. User
has to click Cancel button instead of OK

215064 10404 when flowchart process is unable to gather Platform configuration settings.

213571 Restoring Process box connection for Call List process box result in to error 17583

213569 Segment process 'do not run subsequent processes for empty segments' runs subsequent processes for
empty segments. "

213567 Unable to see newly mapped fields when outputting to mapped table

213566 Right-click button menu is not staying open while working with flowcharts in Safari 7 browser

213565 After applying fixpack 9114, the 'fields to log' disappear in the Log tab of response process box.

213564 The selected field in eMessage process box gets changed automatically in IBM Campaign.

© Copyright IBM Corp. 1998, 2017 11



Table 6. Campaign fixed defects (continued)

ID Fixed defect

213563 Output Fields Are Getting Remapped With Output File Name Change

213561 IBM Campaign : Server side validation doesn't happen on Campaign offer page.

213559 Entry is hanging out of field in Japanese on IE 11 FOR SEGMENT PROCESS BOX

213557 Using Chrome if you add segments to a segment process then try to move the first segment down, it
messes up the list

213554 Offer API default attributes not being populated

213553 'Audience ID field(s)' becomes empty on remapping tables

213551 Removing input from Segment process and then navigating to General tab doesn't remove segments, can
cause segment mismatches

213550 eMessage Landing Pages not appearing for selection in Extract box within Campaign

213548 THROTTLING DATABASE CONNECTIONS WITH THE MAXQUERYTHREADS PARAMETER ON
DATASOURCE DOES NOT WORK.

213547 Condition value retains in Select process box.

213544 SINGLE PROCESS BOX EXECUTION DOWNSTREAM FROM EXECUTED EXTRACT CAUSES TABLE OR
VIEW DOES NOT EXIST ERROR

213543 Null values handled inconsistently in Derived Fields, Else statement in Derived Field

213541 Schedule task fails when flowchart name is changed

213535 User able to update offer in Optimize process box when MO-UC integration is on

213530 Campaign custom attribute in non English characters gets truncated when exported to mapped DB table in
IBM Campaign

213529 ETL calculates treatmentinstid using TargetCellID count

212054 VERSION: 203553: Campaign custom attribute in non English characters gets truncated when exported to
mapped DB table in IBM Campaign

208214 After applying fixpack 9114, the 'fields to log' disappear in the Log tab of response process box.

206338 Wrong message when same flowchart is opened in Edit mode by multiple users in IBM Campaign

205999 Copying/pasting ASCII characters from SQL Developer cause Campaign to be inaccessible

205997 IBM CAMPAIGN: CELLCODE IN TCS NOT CORRECTLY STORED

205995 Catalog window gets currpted if there are many objects

205992 Assigned Offers not displaying in Optimize PB

205991 Removing input from Segment process and then navigating to General tab doesn't remove segments, can
cause segment mismatches

205990 Sorting by 'Start Time' or 'End Time' on Monitoring page may not yield correct sort order

205988 Using "Offer Folder" in Advanced Offer search does not work properly

205987 EMESSAGE -ETL calculates treatmentinstid using TargetCellID count

205986 Offer API default attributes not being populated

205985 IBM Campaign : Server side validation doesn't happen on Campaign offer page.

205984 Running select with input table that don't exists and extract process box (connected to snapshot), both
connecting to merge causes 10404

205982 CUSTOM MACRO FOLDER NOT AT TOP OF THE MACRO FOLDER LIST IN THEQUERY HELPER

205981 CANNOT CLICK ON SCROLL BAR FOR SESSION FLOWCHARTS

205980 Display count of schedule keep increasing when we click Schedule button in a flowchart in IBM Campaign

205979 Table fields are not displayed in alphabetical order during table mapping
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Table 6. Campaign fixed defects (continued)

ID Fixed defect

205978 PO05072 LOG TAB DOES NOT SHOW IN THE CREATED THE DERIVED FIELD UNTILL YOU REFRESH

205973 STOP / PAUSE DISABLED WHEN USER HAS TEST RUN PERMISSION IN IBMCAMPAIGN

205972 String gets truncated in query builder if database column has hyphen.

205970 Copying process boxes to template does not work in Safari. Right mouse click unchecks all boxes in Safari

205969 Remapping user tables quickly can cause duplicate table mappings

205968 EMSSAGE -10404 Error thrown when eMessage Landing Page selected in Extract process

205967 Pull down menu of schedule shows same value multiple times, when the schedules button is clicked
repeatedly.

205965 On schedule run screen the Detail column content is garbled

205963 Target Cell Spreadsheet doesn't display scroll bar for Select Box custom attribute values list

205962 Table column names are out of order when working in table column mapping dialog box

205961 Campaigns listing page doesn't have a functional scroll bar within "VIew a Tab" popup box for campaigns
with large number of flowcharts

205959 IBM Contact Optimization :Execution of Optimize session with ACOOptAdmin.sh fails with error as
"unable to connect to specified URL" 2

05958 Tracking contact history at a different audience level do not work in IC 9.0

205957 Clicking on the Schedules button several times very quickly will lead to displaying duplicate menus

205954 Copying/pasting ASCII characters from SQL Developer cause Campaign to be inaccessible

205953 Table Fields hanging out of the Box for Japanese User on IE 11

205952 IBM Campaign : Cell Attribute of 'Text Field - Numeric' type doesn't save Zero (0) value

205951 Audience sorting only works for primary audience level, not for any additional audience levels

205950 Ability to save table catalog with more than 64 characters, causes db error, unable to load any catalogs
globally

205949 Issue while scheduling flowchart having Japanese characters

205948 Using chrome if you add segments to a segment process then try to move the first segment down, it
messes up the list

205947 THE "UP1" AND "DOWN1" BUTTONS ON PERSONALIZATION TAB OF MAILLIST DO NOT WORK
CONSISTENTLY WITH CHROME BROWSER

205946 Issue on sequence ordering on both snapshot & extract

205945 View log button is not working when using french - Also Unable to Open Campaign and Flowchart with
french Char "ùûéêèëÿ"

205943 New field added in the contact and response history is not available for the existing flowcharts.

205942 THROTTLING DATABASE CONNECTIONS WITH THE MAXQUERYTHREADS PARAMETER ON
DATASOURCE DOES NOT WORK.

205941 EMESSAGE -The selected field in eMessage process box gets changed automatically in IBM Campaign.

205940 Unica don't show parameters of offer in CallList tab

205939 Multiple selection in Profile Select Field applet is not working

205938 Offer Creation from template to use bind variables

205937 Cell attributes not sorting in alphabetical order

205936 IBM CAMPAIGN: ALL THE DIMENSION TABLES LISTED IN SELECT PROCESSARE NOT LISTED IN
FLOWCHART REPORTS

205935 PO04374 TARGET CELL CUSTOM ATTRIBUTES NOT SCROLLING

205934 Null values handled inconsistently in Derived Fields, Else statement in Derived Field
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Table 6. Campaign fixed defects (continued)

ID Fixed defect

205933 SINGLE PROCESS BOX EXECUTION DOWNSTREAM FROM EXECUTED EXTRACT CAUSES TABLE OR
VIEW DOES NOT EXIST ERROR

205932 Persistent derived field issue in french Locale

205931 Unable to Select multiple categories from "Values" in 9.1.0.3

205930 MAILLIST PROCESS BOX GIVING OPTION TO WRITE TO CONTACT HISTORYFOR TEST RUN IN IBM
CAMPAIGN

205929 Editing Custom macro giving name conflict error

205928 Ability to save table catalog with more than 64 characters, causes db error, unable to load any catalogs
globally

202203 Editing Custom macro giving name conflict error

202202 Ability to save table catalog with more than 64 characters, causes db error, unable to load any catalogs
globally

199729 IBM CAMPAIGN: CROSS SITE SCRIPTING ISSUES USING THE NON SUPPORTED BROWSER FIREFOX

196876 Sensitive Parameters Passed In GET Request .

196328 SQL30081N TCP/IP SOCKET CLOSURE ERROR WHILE RUNNING UNICA_ACSVR PROCESS
COMMUNICATES TO THE DB2 DATABASE

190160 Contact history combines separate cells into a single treatment

183490 Folder owner permissions not being respected for loading catalogs

176048 unica_acsvr process does not exited when login to platform and again logout from browser without going
to Campaign page.

136811 Snapshot Process Up1/Down1 buttons don't always work properly and scrollbar jumps incorrectly when
these buttons are used

130933 Scrollbar sliders do not move when clicked/dragged during table mapping/re-mapping

18991 If a user creates a flowchart in multi locales then persistent

17199 Offer attributes in wrong display
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Chapter 4. Known issues in IBM Campaign 10.0

Campaign 10.0 includes the following known issues.

Table 7. Campaign known issues

ID Known issue

239142 When the Audience process fails because of an incorrect Count filter expression, and the user removes
the filter expression, adds a Condition, and runs the Audience process again, the process fails. The
Condition is not considered and instead the previous Count filter expression is used resulting in the
failure. To run the Audience process successfully, you must re-open the Audience process configuration
window, click the Condition, Save and Close. The Audience process now considers the Condition and
runs successfully.

229870 The issue: IBM Campaign 10.0 release installs IBM Global Security Kit (GSKit) version 8.0.50.41. IBM
Global Security Kit (GSKit) is a common component that is used by a number of IBM products for its
cryptographic and SSL/TLS capabilities. IBM Campaign installs IBM GSkit as a global level install.
IBM Global Security Kit (GSKit) installation requires root user role in case of UNIX and Administrator
user role in case of Windows machine. However, if IBM Campaign 10.0 installation or the upgrade is
done with the non-root user role or the non-admin user role, then the IBM Global Security Kit (GSKit)
will not be installed. IBM Campaign 10.0 installation log does not show any error message on failure of
IBM Global Security Kit (GSKit) installation and with the SSL configured in the IBM Campaign v10.0
environment, the user will not be able to start the Campaign analytical Server.

Workarounds: Run IBM_Campaign_Crypto_10.0.0.0_IF02_<Operating_System> command on the system
where IBM Campaign analytical server is installed. This would install the IBM Global Security Kit.
Ensure that you execute the command using root user role on UNIX and administrator user role on
Windows. For detailed steps, refer to the IBM_Campaign_10.0.0.0_IF02_Readme.txt.

214084 The parenthesis ")" character used in a process box name shows incorrectly in Cell reports as a single
right square bracket "]".

224257 The issue: You modify a campaign on the Campaign Summary page, then run advSrchUtil without
opening and saving flowcharts in the campaign. The modified campaign configuration is not
searchable in those flowcharts. This is a rare use case. Users typically open the flowcharts, make
changes, and save. This problem does not occur for flowcharts that are saved after modifying the
campaign summary configuration.

Example: "Campaign A" has three flowcharts: FC1, FC2, and FC3. You change the description of
"Campaign A" to include the word "IBM", then open FC3 and save it. You do not touch the other
flowcharts. Now if you run advSrchUtil, searches for "IBM" will find FC3. However, the other
flowcharts will not appear in the search results, because advSrchUtil did not reindex them (as their
timestamp did not change).

Workarounds: Use one of the following workarounds:

v Delete the file .advSrchUtil.last in <CAMPAIGN_HOME>/bin/ before running advSrchUtil to force
indexing of all flowcharts in the given partition.

v Open the flowcharts and save them before running advSrchUtil.

v Use unica_acsesutil with the -J option to index individual affected session files.

213697 Campaign application images are not displayed when Campaign is deployed in WebLogic 12.1.1. To
display images, add the following lines to the Campaign/WEB-INF/web.xml file:

<filter-mapping>
<filter-name>springSecurityFilterChain</filter-name>

<url-pattern>*.svg</url-pattern>
</filter-mapping>
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Table 7. Campaign known issues (continued)

ID Known issue

220609 Deleting a flowchart displays the following error message: Could not complete the requested
operation. org.apache.axis2.AxisFault: javax.xml.stream.XMLStreamException: White space is required
between "SYSTEM" and the system identifier. See campaignweb.log on the web application server for
details. Also see the listener log files: masterlistener.log and unica_aclsnr.log.

219602 Engage: Push process box execution failed when all mapped fields were marked as Sync fields. Push
process box execution failed with the following error message:

21901: Internal error. Error received from IBM Engage: Error executing import of list. Details: Error
Appending and Updating Recipients. Job id:

This error occurred when user marked more than required fields as synch fields. From Campaign,
users can mark the fields as Sync fields which are allowed as Sync fields from Engage database.

213733 When viewing Campaign reports from the Campaign > Analytics tab in PDF mode, the Reports
drop-down list is hidden behind the reports view. This is a known issue with Microsoft Internet
Explorer.

222234 Enabling temp tables blocks the execution of all process boxes and throws error " ORA-00942 :Table or
view doesn't exist." This occurs when you open a flowchart for editing, choose Advanced settings >
Server optimization, and uncheck Disallow use of temp tables for this flowchart.

One of the reasons this error occurred is because the user changed the "TempTablePrefix" after the
TEMP tables were allocated and being used in a flowchart. To overcome this error:

1. Users can clean up the temp table pool allocation to overcome this error. See https://www.ibm.com/
developerworks/community/wikis/home?lang=en#!/wiki/W3a9d2a3c495a_47b6_97a9_e2b8f68b2e88/
page/Understanding%20the%20TempTablePool% 20Feature%20for%20IBM%20Campaign

2. Disable temp table for that particular flowchart: Choose Advanced settings > Server optimization,
and uncheck Disallow use of temp tables for this flowchart.

213372 Some searchable fields are not getting searched in the Extract process box. The Optimize list referenced
in the Extract process box is not searchable in the Flowchart Advance Search feature.

204347 LARGE_DATA: Browser Crash - Mail List process box with 700 segments - Save with 512 offers to each
segment.

220705 LARGE_DATA: Profiling count for Dimension table fields is incorrect and profiling percentage
displayed 100% but profiling is in progress.

222087 Offer folders are not replicated on other cluster nodes of Campaign web application.

213600 User DB Testing: Amazon Redshift: Incorrect cell size on Select process box when In-DB optimization is
enabled.

211253 File-based input with multiple columns containing date in different format does not read the date
correctly.

221771 Derived field with value 40.68 when exported to new Snapshot table - lost the precision.

213525 HP Vertica: Error while exporting data from table with Boolean data type.

212890 Boolean type column on Amazon Redshift is recognized as 'Test' field type in table mapping.

194989 Campaign server process crashed with error 10404 while executing Segment process box.

Workaround: For all Segment process boxes that have Create Extract tables checked:

1. Uncheck the Create Extract tables option in the Segment process box.

2. Add an Extract process box downstream of the Segment process box and use this extract output in
subsequent processes.
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Table 7. Campaign known issues (continued)

ID Known issue

198739 Track and Response process box execution failed with error 10404 and a stack trace was generated
when Use In-DB Optimization was selected under flowchart Advanced Settings.

Workaround: Disable Use In-DB Optimization in the flowchart that contains the Track or Response
process box along with other process boxes. If that is not possible, create a new flowchart and
configure only Select and Track and /or Response in the new flowchart and you can enable Use In-DB
Optimization here.

185658 Big data: Unable to copy data to big data output tables when loader delimiter is "\t"

Hive-based Hadoop big data does not support the Tab (/t) character. Do not use the Tab character as
the LoaderDelimiter value (Campaign|partitions|partition[n]|dataSources|dataSourcename).

194575 Big data: Segment process box execution fails with error when Create Extract Tables option is checked.
Workaround: Extract within Segment can be achieved by placing the Extract process downstream of the
Segment process.

NA Big data: The temporary data file upload location on the Hive server must be /tmp.

The property LoaderPreLoadDataFileCopyCmd
(Campaign|partitions|partition[n]|dataSources|dataSourcename) is used for Hive-based Hadoop data
sources (BigDataODBCHiveTemplate). This property uses SCP to copy data from IBM Campaign to a
temp folder on the Hive-based Hadoop system. Currently, the location must be called /tmp. This must
be the file system location, not the HDFS location.

175825 When defaultBehaviorWhenOutputToFile is set to Create New File, it works only when you select a
new output (export) file for the first time. If you try to change the existing output file and select a new
output file, then the option Append to Existing Data gets selected by default. It can be changed
manually to Create New File.

176876 If you input more than 21 DBCS characters into a User Variable Name, the following error message
occurs: 11532 Length Exceed Error: User Variable Name exceeds 64 characters for UserVar at
location[0]

178526 You can safely ignore the following non-fatal error in the Campaign_Install.log. The error is logged if
you interrupt and then restart the Campaign installation.
"com.unica.install.ia.custom.ManagerReadConfigurationStatus: ERRORAdditional Notes®: ERROR -
class com.unica.install.ia.custom.ManagerReadConfiguration NonfatalInstallException The processing
instruction target matching "[xX][mM][lL]" is not allowed."

NA Mail List process box gets unconfigured with error "31606: History table are changed" on Flowchart
run.

1. There is no issue if the history tables are mapped prior to building a flowchart and adding a Mail
List process. 2) If you do not follow step 1, you can still map the history tables after the error appears.
If you edit the flowchart and configure the process box, the process will run.

NA After migrating non-ASCII data to Campaign 8.6, in some cases you cannot open Campaign flowcharts
on the target system. Session flowcharts open successfully. To work around this issue, remigrate the
campaigns in overwrite mode. You can then open the flowcharts.

2968 Hot keys are not implemented on most of the windows. In the Dojo implementation it is not possible
to use keyboard shortcuts to activate certain functions. Instead the user must click buttons.

13460 When the Export to File option is unchecked on the Fulfillment tab of the Mail List process box, the
Summary File option is enabled but should not be.

TT
DEF062333

Information related to associated products does not appear in offer on Marketing Operations. When an
offer created in Campaign with products associated with it is imported in Marketing Operations,
information about the associated products is not available in Marketing Operations.

TT
DEF063392

Clicking "Return to previous page" distorts the UI in some cases. Use the links within the products to
navigate, rather than the browser controls.
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Table 7. Campaign known issues (continued)

ID Known issue

75262 Clicking "Return to previous page" distorts the UI in some cases. Use the links within the products to
navigate, rather than the browser controls.
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Chapter 5. Known limitations in IBM Campaign 10.0

Campaign 10.0 includes the following known limitations.

Table 8. Campaign known limitations

ID Known limitation

232032 You can start only one IBM Campaign listener on one server (machine).

217488 IBM can support the Database Loader for Redshift until the moment Campaign triggers the Loader Script.
Any problems in execution of the loader script are not supported by IBM.

222934 Search performance on the Advanced Search UI: The time for search results to appear on the UI, when the
page size is 500 is somewhat long. For example, it takes about 30 seconds on IE11. For other page sizes,
such as 10 (default), 25, 50 and 100, the performance is good.

213088 If IBM Campaign is installed in a secured environment but IBM Cognos is in an unsecured environment,
Cognos reports will not display when you use Microsoft Internet Explorer 11. Workaround: If IBM
Campaign is configured with HTTPS, also configure IBM Cognos on HTTPS.

211293 In IBM Campaign, the built-in macro Current_Date() results in an error when executed against a Hive 1.2
based Big Data instance. The Hive ODBC driver does not support the CURRENT_DATE macro to obtain
interval values. For example, executing the following query results in a Hive error:

SELECT DISTINCT customerid FROM Customer_date WHERE ((Customer_date.my_date_mmdyyyy -
CURRENT_DATE()) >= 7)

Error: Hive 2 Internal error: unsupported conversion from type: interval_day_time

Workaround: To use the CURRENT_DATE function in a RAW SQL query on Hive with Hortonworks,
execute SQL in the following format:

SELECT DISTINCT customerid FROM Customer_date WHERE (current_date() - my_date_mmdyyyy ) =
interval '0 0:0:0' day to second

NA Big data: To perform the UPDATE operation on any process boxes in a flowchart, ensure that your HIVE
tables are configured as transactional tables such that they support the ACID property. This is a key
feature introduced in HIVE version 0.14.

190621 Big data: Campaign with Hive big data as a user database does not support user table mapping with Base
and Dimension levels up to the fourth level hierarchy.

If you map a Base record table with four levels of dimension tables in a Select process box, then build a
query based on the fourth level Dimension table, the query fails with Error 11528. This issue should not
affect big data users because multiple dimensions should not be needed. By definition, a big data source
has a large table of records split across Hadoop nodes (such as HDFS).

185854 Big data: Campaign integration with Hadoop-based Hive big data as a user data source is not tested on
MS Windows operating system.

194095 For Redshift database, the error message "Unsupported type timestamps with time zone" is displayed
when exporting data from a Snapshot process box. Timestamp with timezone is an unsupported
PostgreSQL data type on Amazon AWS.

194806 BLU: Snapshot process box execution fails with error when records are exported with option Replace All
Records. The error occurs with BLU DB2 database and only when Replace All Records is selected. It does
not occur for Append to Existing.

NA IBM Interact when configured with IBM WebSphere Application Server: You must configure IBM
WebSphere JVM to use JDK 1.7. When IBM WebSphere Application Server 8.5.5.x is configured with JDK
1.7 and HTTPS communication, you must use IBM JAVA SDK version 7.0.8.10 or higher.
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Table 8. Campaign known limitations (continued)

ID Known limitation

NA Using multiple SQL statements for raw SQL queries is not currently supported on big data user
datasources. For related information, search the IBM Knowledge Center for Hive query language
conformance.

195581 While running a Campaign flowchart, if listener crashes or is stopped, user is not able to access the
running flowchart from the UI. Requests are being served by another node of the cluster but while
accessing the flowchart, a pop-up message says "listener failover occurred..." It may be necessary to restart
the master listener.

196487 DataDirect + Cloudera: Snapshot process box execution fails when some of the output table column fields
are not mapped. This is related to a known issue with the Hive 0.14 database. Workaround: To extract
fewer than the fields in the mapped database table, fill them with derived fields or uservars and fill them
with the default desired values, such as NULL.

184919 Big data: Mail List process execution fails with error: unique constraint
(UCDUC9111.CCONTACTHIST_PK) violated.

Mail List / Call List process box execution completes successfully when User Database table - Audience
Level is BigInt. However:

v When a user profile table contains Audience ID in Decimal format, this error will occur.

v When a user profile table is created by export from File to Database then by default all numeric fields
are created as Decimal.

For big data: The user profile database table audienceID should be of BigInt type when used with DB2
databases. If the user profile database table audienceID is Decimal, the Mail List / Call List process box
execution will have errors.

186489 Big data: "Record exported = Unknown" is displayed on Snapshot process box if cell size Limit is used in
preceding Select process box.

(1) Count of records is unknown when a Snapshot is populated through INSERT INTO SELECT FROM
queries. If you want a record count, map it as Base table, in which case Campaign will compute the record
count. (2) Count of records will be known and updated in case of loader (LOAD DATA) invocation. No
need to map the table.

NA Flowchart annotations are not affected by zoom. You cannot resize annotations. Annotations do not appear
in the panning area. Annotations can be moved out of the flowchart window and the only way to access
them is to move the associated process box in the direction of the annotation, then drag the annotation
back to the main flowchart area and move the process box back to its original position. If an annotation
overlaps a process box, drag the annotation to another position.

176377 DB2 10.5 BLU for user DB: No indexing requirement for temp tables in Campaign datasource. DB2 10.5
(with BLU feature ON) does not require indexing in Campaign. Campaign has certain properties for
datasources, such as TempTablePreTruncateRunScript, TempTablePostExecutionSQL, and
PostTempTableCreateRunScript, where you can provide SQL or scripts to create indexes on user database
tables. If you are using DB2 10.5 as a customer database, with the BLU feature ON, you do not need to
configure any of these temp table properties.

NA Dialog behavior: In certain cases, it is necessary to click twice in order to activate a field or change a field
value.

NA The monitorEnabledForEmessage configuration property in Campaign|monitoring is not currently used.

NA Relevant products limitation: When offer management is performed from IBM Marketing Operations, the
"relevant products" functionality, which relates product IDs to offers, is not available.
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Table 8. Campaign known limitations (continued)

ID Known limitation

NA Blank or incorrect results from derived fields in a Mail List process. This can occur in a process box that
uses a derived field that calls a Generated field (UCGF) that changes value.

Do not use a UCGF in a Mail List derived field if the UCGF is not constant. Also, from the Parameters tab,
do not create a derived field to call a UCGF to populate offer attributes.

For details, see the following Tech Note: http://g01zciwas018.ahe.pok.ibm.com/support/dcf/
preview.wss?host=g01zcidbs003.ahe.pok.ibm.com&db=support/swg/istech.nsf
&unid=C4A93DC0ED188D6985257A6B00699C45&taxOC=SSCKNRB&MD=2012/08/31%2015:08:35&sid=

NA Profiling a Campaign Generated Field (UCGF) does not yield correct results. Some UCGFs have a value
according to the cell or the offer being processed. For cell-related UCGFs, only the value associated with
the first cell appears during profiling.

NA The default value for a custom cell attribute does not appear when you open the target cell spreadsheet.
Although the default value is not initially displayed, it will be used. The value can be displayed or
changed by clicking or opening and editing the custom cell attribute in the target cell spreadsheet.

NA The UA_UsrResponseType.Name field cannot contain a left parenthesis followed by a single quote.

NA Use unique TempTablePrefix for each data source when mapping multiple data sources to same physical
database.

If you mapped multiple data sources in Campaign to the same physical database, and you use the same
TempTablePrefix for more than one of the data sources, when you use the cleanup utility to delete
orphaned temp tables, it may falsely identify temp tables as orphaned, when they are in fact legitimate
temp tables defined from a different Campaign data source.

Any deleted temp tables will automatically be recreated when you rerun affected flowcharts, but as a best
practice, use a unique TempTablePrefix for each data source when mapping multiple data sources to the
same physical database.

If the data sources defined in Campaign map to different schemas in the database, another solution is to
ensure that the database user who runs the cleanup utility does not have privileges to drop tables in other
schemas in the same database.

11162 Several dialogs that might not contain a large amount of data or are not commonly used cannot be resized
or maximized.

17202 Error 19024: Cannot delete segment folder if the segment was deleted from the folder. A segment that is
deleted from a folder remains as an inactive segment in the folder. Folders with inactive segments cannot
be deleted. This is working as intended.

18991 If the same flowchart is edited in multiple locales, undesired behavior can occur. This situation occurs only
if two (or more) users with different language settings edit the same flowchart. Users with different locales
should not edit the same flowchart that was created by a user with a different locale since this can lead to
undesired behavior. The preferred approach is to create and edit flowcharts with users having the same
language settings.

84147 Copy and paste behavior in process boxes and other dialogs: For security reasons, some browsers do not
allow applications to copy and paste via the Clipboard. This affects the General tab of the Segment process
configuration and other areas of the application where copy and paste might be used.

161323 The error "Login failed. Error 10553" can occur if you try to log in to the Campaign utilities when the IBM
Marketing Platform | Security | login method is set to Windows integrated login or Web access control.
To avoid this issue, change the login type to LDAP or IBM Marketing Platform prior to using the
Campaign utilities.

201968,
200241

If two process boxes are moved very close together in a flowchart, the direction of the connection arrow
changes. This limitation affects the visual representation of the arrow. The process data flow is not
affected. The workaround is to move the process boxes farther apart so the arrowhead changes back to the
correct direction.
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Chapter 6. IBM Campaign Reports Package

The Campaign Reports Package delivers reporting schemas that you can use to
track campaign, offer, and cell performance. To use the Reports Package, Campaign
must be integrated with IBM Cognos

For more information, see the IBM Marketing Software Reports Installation and
Configuration Guide that is supplied with IBM Marketing Platform.

The IBM Campaign Reports Package contains the following items:
v Schemas that are registered with IBM Marketing Platform during installation.

They describe the attributes and metrics that represent the product's reporting
schema and include:
– Base schemas that are the basis of the reporting schema (with no custom

attributes)
– Custom versions of most of the base schemas that rely on the preconfigured

custom attributes for Campaign
– Templates that you can use to create new schemas

v IBM Cognos customizable model and reports to be deployed on an IBM Cognos
BI Server

v Reference documentation that describes the IBM Cognos model and the reports.
Documentation can be found in the directory ReportsPackCampaign\cognos10\
CampaignDocs.

The Campaign reports retrieve data from one data source: the Campaign system
tables.

Reporting Schemas

The following reporting schemas are provided:
v Campaign Views provides the standard attribute views of the Campaign system

tables (campaign, offer, cell, and so on).
v Campaign Custom Attributes is for reporting on custom attributes of campaigns,

offers, and cells.
v Campaign Performance is used by reports that display performance

measurements starting at the campaign level over all time or various periods of
time (days, months, and so on).

v Offer Performance is used by reports that display performance measurements
starting at the offer level over all time or various periods of time (days, months,
and so on).

v Campaign Offer Response Breakout is used by reports that show campaign and
offer responses based on response types.

v Campaign Offer Contact Status Breakout is used for measurement of campaign
and offer contacts based on contact status.

The custom schemas extend the last five of the listed schemas to include the
default, preconfigured response types, custom attributes, and so on.

© Copyright IBM Corp. 1998, 2017 23



Templates

If you have additional audience levels, you can create additional reporting schemas
for them with the following templates:
v Campaign Views
v Campaign Custom Attributes
v Campaign Performance
v Offer Performance
v Campaign Offer Response Breakout
v Campaign Offer Contact Status Breakout

Reports

The reports package contains Cognos example reports that can be accessed from
the Analytics menu or the Analysis tab for a campaign or offer. Reports can also be
displayed in portlets on the Dashboard.

The following campaign-specific example reports are available from the Campaign
Analysis tab:
v Campaign Detailed Offer Response Breakout
v Campaign Financial Summary by Offer (Actual)
v Campaign Offer Performance by Month
v Campaign Performance Summary by Cell
v Campaign Performance Summary by Cell with Revenue
v Campaign Performance Summary by Offer
v Campaign Performance Summary by Cell and Offer
v Campaign Performance Summary by Cell and Offer (with Revenue)

The following offer example reports are available from the Offer Analysis tab:
v "What If" Offer Financial Summary
v Offer Performance by Day
v Offer Performance Summary by Campaign

The following cross-object example reports include information about multiple
objects in Campaign. These reports are available from the Campaign Analytics
page.
v "What If" Offer Financial Summary
v Campaign Detailed Offer Response Breakout
v Campaign Financial Summary by Offer (Actual)
v Campaign Offer Performance by Month
v Campaign Performance Comparison
v Campaign Performance Comparison (with Revenue)
v Campaign Performance Comparison by Initiative
v Campaign Performance Summary by Cell
v Campaign Performance Summary by Cell (with Revenue)
v Campaign Performance Summary by Cell by Initiative
v Campaign Performance Summary by Offer
v Campaign Performance Summary by Offer (with Revenue)
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v Campaign Performance Summary by Cell and Offer
v Campaign Performance Summary by Cell and Offer (with Revenue)
v Campaign Summary
v Offer Campaign Listings
v Offer Performance by Day
v Offer Performance Comparison
v Offer Performance Metrics
v Offer Performance Summary by Campaign

The following campaign-specific example report portlets are available on
dashboard pages:
v Campaign Response Rate Comparison
v Campaign Return on Investment Comparison
v Campaign Revenue Comparison by Offer
v Offer Response Breakout
v Offer Response Rate Comparison
v Offer Responses for Last 7 Days
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Before you contact IBM technical support

If you encounter a problem that you cannot resolve by consulting the
documentation, your company's designated support contact can log a call with
IBM technical support. Use these guidelines to ensure that your problem is
resolved efficiently and successfully.

If you are not a designated support contact at your company, contact your IBM
administrator for information.

Note: Technical Support does not write or create API scripts. For assistance in
implementing our API offerings, contact IBM Professional Services.

Information to gather

Before you contact IBM technical support, gather the following information:
v A brief description of the nature of your issue.
v Detailed error messages that you see when the issue occurs.
v Detailed steps to reproduce the issue.
v Related log files, session files, configuration files, and data files.
v Information about your product and system environment, which you can obtain

as described in "System information."

System information

When you call IBM technical support, you might be asked to provide information
about your environment.

If your problem does not prevent you from logging in, much of this information is
available on the About page, which provides information about your installed IBM
applications.

You can access the About page by selecting Help > About. If the About page is not
accessible, check for a version.txt file that is located under the installation
directory for your application.

Contact information for IBM technical support

For ways to contact IBM technical support, see the IBM Product Technical Support
website: (http://www.ibm.com/support/entry/portal/open_service_request).

Note: To enter a support request, you must log in with an IBM account. This
account must be linked to your IBM customer number. To learn more about
associating your account with your IBM customer number, see Support Resources
> Entitled Software Support on the Support Portal.
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Notices

This information was developed for products and services offered in the U.S.A.

IBM may not offer the products, services, or features discussed in this document in
other countries. Consult your local IBM representative for information on the
products and services currently available in your area. Any reference to an IBM
product, program, or service is not intended to state or imply that only that IBM
product, program, or service may be used. Any functionally equivalent product,
program, or service that does not infringe any IBM intellectual property right may
be used instead. However, it is the user's responsibility to evaluate and verify the
operation of any non-IBM product, program, or service.

IBM may have patents or pending patent applications covering subject matter
described in this document. The furnishing of this document does not grant you
any license to these patents. You can send license inquiries, in writing, to:

IBM Director of Licensing
IBM Corporation
North Castle Drive
Armonk, NY 10504-1785
U.S.A.

For license inquiries regarding double-byte (DBCS) information, contact the IBM
Intellectual Property Department in your country or send inquiries, in writing, to:

Intellectual Property Licensing
Legal and Intellectual Property Law
IBM Japan, Ltd.
19-21, Nihonbashi-Hakozakicho, Chuo-ku
Tokyo 103-8510, Japan

The following paragraph does not apply to the United Kingdom or any other
country where such provisions are inconsistent with local law: INTERNATIONAL
BUSINESS MACHINES CORPORATION PROVIDES THIS PUBLICATION "AS IS"
WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESS OR IMPLIED,
INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF
NON-INFRINGEMENT, MERCHANTABILITY OR FITNESS FOR A PARTICULAR
PURPOSE. Some states do not allow disclaimer of express or implied warranties in
certain transactions, therefore, this statement may not apply to you.

This information could include technical inaccuracies or typographical errors.
Changes are periodically made to the information herein; these changes will be
incorporated in new editions of the publication. IBM may make improvements
and/or changes in the product(s) and/or the program(s) described in this
publication at any time without notice.

Any references in this information to non-IBM Web sites are provided for
convenience only and do not in any manner serve as an endorsement of those Web
sites. The materials at those Web sites are not part of the materials for this IBM
product and use of those Web sites is at your own risk.
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IBM may use or distribute any of the information you supply in any way it
believes appropriate without incurring any obligation to you.

Licensees of this program who wish to have information about it for the purpose
of enabling: (i) the exchange of information between independently created
programs and other programs (including this one) and (ii) the mutual use of the
information which has been exchanged, should contact:

IBM Corporation
B1WA LKG1
550 King Street
Littleton, MA 01460-1250
U.S.A.

Such information may be available, subject to appropriate terms and conditions,
including in some cases, payment of a fee.

The licensed program described in this document and all licensed material
available for it are provided by IBM under terms of the IBM Customer Agreement,
IBM International Program License Agreement or any equivalent agreement
between us.

Any performance data contained herein was determined in a controlled
environment. Therefore, the results obtained in other operating environments may
vary significantly. Some measurements may have been made on development-level
systems and there is no guarantee that these measurements will be the same on
generally available systems. Furthermore, some measurements may have been
estimated through extrapolation. Actual results may vary. Users of this document
should verify the applicable data for their specific environment.

Information concerning non-IBM products was obtained from the suppliers of
those products, their published announcements or other publicly available sources.
IBM has not tested those products and cannot confirm the accuracy of
performance, compatibility or any other claims related to non-IBM products.
Questions on the capabilities of non-IBM products should be addressed to the
suppliers of those products.

All statements regarding IBM's future direction or intent are subject to change or
withdrawal without notice, and represent goals and objectives only.

All IBM prices shown are IBM's suggested retail prices, are current and are subject
to change without notice. Dealer prices may vary.

This information contains examples of data and reports used in daily business
operations. To illustrate them as completely as possible, the examples include the
names of individuals, companies, brands, and products. All of these names are
fictitious and any similarity to the names and addresses used by an actual business
enterprise is entirely coincidental.

COPYRIGHT LICENSE:

This information contains sample application programs in source language, which
illustrate programming techniques on various operating platforms. You may copy,
modify, and distribute these sample programs in any form without payment to
IBM, for the purposes of developing, using, marketing or distributing application
programs conforming to the application programming interface for the operating
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platform for which the sample programs are written. These examples have not
been thoroughly tested under all conditions. IBM, therefore, cannot guarantee or
imply reliability, serviceability, or function of these programs. The sample
programs are provided "AS IS", without warranty of any kind. IBM shall not be
liable for any damages arising out of your use of the sample programs.

If you are viewing this information softcopy, the photographs and color
illustrations may not appear.

Trademarks
IBM, the IBM logo, and ibm.com are trademarks or registered trademarks of
International Business Machines Corp., registered in many jurisdictions worldwide.
Other product and service names might be trademarks of IBM or other companies.
A current list of IBM trademarks is available on the Web at "Copyright and
trademark information" at www.ibm.com/legal/copytrade.shtml.

Privacy Policy and Terms of Use Considerations
IBM Software products, including software as a service solutions, ("Software
Offerings") may use cookies or other technologies to collect product usage
information, to help improve the end user experience, to tailor interactions with
the end user or for other purposes. A cookie is a piece of data that a web site can
send to your browser, which may then be stored on your computer as a tag that
identifies your computer. In many cases, no personal information is collected by
these cookies. If a Software Offering you are using enables you to collect personal
information through cookies and similar technologies, we inform you about the
specifics below.

Depending upon the configurations deployed, this Software Offering may use
session and persistent cookies that collect each user's user name, and other
personal information for purposes of session management, enhanced user usability,
or other usage tracking or functional purposes. These cookies can be disabled, but
disabling them will also eliminate the functionality they enable.

Various jurisdictions regulate the collection of personal information through
cookies and similar technologies. If the configurations deployed for this Software
Offering provide you as customer the ability to collect personal information from
end users via cookies and other technologies, you should seek your own legal
advice about any laws applicable to such data collection, including any
requirements for providing notice and consent where appropriate.

IBM requires that Clients (1) provide a clear and conspicuous link to Customer's
website terms of use (e.g. privacy policy) which includes a link to IBM's and
Client's data collection and use practices, (2) notify that cookies and clear gifs/web
beacons are being placed on the visitor's computer by IBM on the Client's behalf
along with an explanation of the purpose of such technology, and (3) to the extent
required by law, obtain consent from website visitors prior to the placement of
cookies and clear gifs/web beacons placed by Client or IBM on Client's behalf on
website visitor's devices

For more information about the use of various technologies, including cookies, for
these purposes, See IBM's Online Privacy Statement at: http://www.ibm.com/
privacy/details/us/en section entitled "Cookies, Web Beacons and Other
Technologies."
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